
1Touchpad Information Technology-IX (Answer Key)

	 Introduction to IT & ITeS� Unit 1: Introduction to IT–ITeS Industry

Unsolved Exercise
Section A

A. 	 1.	 iv	 2.	 iii	 3.	 iv	 4.	 i	 5.	 iii
B. 	 1.	 Online chatting		 2.	 Telemedicine	 3.	 ERP	 4.	 Satellites
	 5.	 Social Networking

Section B
A. 	 1.	 Following are the types of BPO Services.
		  Customer Support Services: These services are related to giving information to clients 

by responding through Chatbot, Voice, e-Mail, Chats, etc. Such customer support centers 
operate 24x7 throughout the year. Examples include, resolving customer queries related to 
travel, order status, product information, grievance handling, etc.

		  Technical Support Services: These types of BPO services provide technical knowledge 
at the outsourced centre to resolve customer queries pertaining to computer hardware, 
software, peripherals and the internet. The queries handled include online training for user 
registration, to recover password, installation, product support, troubleshooting and usage 
support. For example: if a customer is unable to install an application into his computer, it 
is the online technician who troubleshoots the issue.

		  Data-Entry Services: These type of BPO services include entering data at a fast pace taking 
care to maintain a high degree of accuracy. For example: maintaining data related to sales, 
data entry of student details, data entry of voters, mortgage, etc.

		  Accounting Services: These types of BPOs include services related to maintaining general 
ledger, financial statements, balance-sheets, bank reconciliation statements, assets and 
liabilities, etc.

		  Online Services: Such BPO services include online sales and purchases, e-booking, e-ticketing, 
etc.

1.
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	 2.	 Computers facilitate the criminal identification and law enforcement departments in:
•	 �Tracking: The location of suspicious person or accused can now be tracked through their 

mobile phone signals.
•	 Digital Criminal Record: The criminal investigation departments are now able to maintain 

the records of each criminal digitally in computer. Police stations do not have to send huge 
paper files to Police Headquarters for any analysis as all crime records are electronically 
stored in their central computers (server) which can be accessed from anywhere with 
proper authentication.

•	 Analysis: The criminal investigation departments do comparative analysis of nature of 
crimes in each state and watch trend on different crimes through software generated 
statistics on computer.

•	 DNA Test: This is a form of examination of hair sample, blood sample, etc. by the use of 
computer technology to identify people associated with a criminal case.

•	 Immigration Records: There are a large number of foreign nationals and non-residents 
travel to a country every year. The Immigration departments maintain passport and visa 
records of all these visitors on computers and accordingly monitor their entry and exit 
from the country.

	 3.	 Computers have enhanced the way in which museums and libraries are accessed.
•	 Tracking of Resources: The updated records are fed in computers and visitors can trace 

their requirements or areas of interest themselves from user terminals located in libraries 
and museums.

•	 Digital Historical Data: Records of objects in the museum like the discovery date, location 
of excavation, relevance of that object in the historic times and other such details which 
may interest the visitors are electronically maintained.

•	 Book Issue Records: Records of issue, renewing and return of books and CDs are 
maintained with more accuracy in libraries.

•	 Indexing: Instead of searching different shelves of the library for a particular book, one 
can speedily search the shelf it is in with data recorded in computer.

•	 Online Access of Books: One can read e-Books, newspapers, journals, research papers 
in soft copy version.

	 4.	 Computer science has led to the development of artificial intelligence in the form of robotics 
which is concerned with design, construction, and operation of robots that can substitute 
for humans and replicate human actions.

	 5.	 Outsourcing is usually defined as “The process of an organization entering into a contract 
with another organization to operate and manage one or more of its operations or functions 
of the parent company”.
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	 6.	 The opportunities in I.T. industries can be broadly classified into:
•	 Software Development
•	 I.T. Application
•	 I.T. enabled Services (ITES)

	 7.	 It is computer-based examination system (paperless examination) that has completely 
automated the old manual procedure of conducting exams as the tests are taken on 
computers online. Examination data can be stored conveniently in a very less space and it 
also takes less time for evaluation.

	 8.	 It enables the user at different locations to hold face-to-face meetings without moving to 
a single location together with the help of computers and Internet.

	 9.	 •	 �Telemedicine: The information technology and telecommunication are now used to 
provide health care to people living in far off distance.

•	 Computer Controlled Medical Devices: The diagnosis of diseases are now possible with 
the computer-controlled devices like ultrasonography, CT scan, X-rays, ECG, etc.

•	 �Computerization of Hospital Management System: Hospitals are using computers to 
maintained Real time data on bed availability, doctors and other staff on duty, generation 
of accurate bills of patients, etc.

•	 �Digital Patient Records: Medical records of patients are maintained electronically for 
quick reference and access instead of being archived in paper files like in the past.

•	 �Computerized Labs: Today, Modern diagnostic laboratories have computerized devices 
to test samples and infer accurate results.

•	 �Computerized Pharmacies: Computers are now able to check vital details like composition 
of medicines, expiry dates, inventory, etc. in pharmacies.

	 10.	 In modern warfare, computers analyze pictures taken from satellites for tracking enemy 
movements. Many technologies like GPS (Global Positioning System) and the Internet were 
initially created or started for the defense services. Computers are an important aspect of 
the defense industry. Advanced IT tools facilitates:
•	 Design of Weapons: Computers are now helping in designing new and advanced forms 

of weapons.
•	 �Coding, Decoding and Transmission of Confidential Messages: There are certain 

confidential information related to security of the nation which requires extreme secrecy 
in delivery. These confidential information and classified files are now transmitted in the 
form of encrypted messages and with multiple levels of coding using specialized computer 
software and the same is decoded at the receiving end using proper authentication and 
decoding software.

•	 �Identification: The pictures of enemy troop movements are taken through satellites and 
plotted using computers thus identifying the exact enemy locations.
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•	 �Simulation: Missile operations are first tested or simulated on computers before the 
final implementation.

B. 	 1.	 Insurance services, Customer Care Support services
	 2.	 •	 UMANG app			   •	 MyGov app

•	 mParivahan app		  •	 MADAD app
•	 BHIM UPI app			   •	 GST rate Finder app
•	 mAadhaar app			   •	 mPassport app
•	 Aarogya Setu app	 •	 DigiLocker app

	Data Entry & Keyboard Skills
Unit 2: Data Entry and Keyboarding Skills

Unsolved Exercise
Section A

A. 	 1.	 iv	 2.	 i	 3.	 iv	 4.	 i	 5.	 iii
B. 	 1.	 Words Per Minute (WPM)	 2.	 Arrow keys	 3.	 Ctrl	 4.	 Function	 5.	 Keyboards
C. 	 1.	 False	 2.	 False	 3.	 True	 4.	 False	 5.	 False

Section B
A. 	 1.	 Following are the different types of keys:

•	 Alphabet Keys: There are 26 Alphabet keys (A–Z) on a keyboard that help to type letters. 
•	 Number Keys: There are ten (10) Numeric keys (0–9) on a keyboard. They help to type 

numbers.
•	 �Function Keys: These keys lie on the upper side of a keyboard (above the Number keys). 

They are labelled as F1, F2, .......... F12.
•	 Arrow Keys: Arrow keys are the direction keys which moves arrows in different directions 

i.e., Up, Down, Left and Right. These keys are useful when one has to move the cursor 
across the screen. 

•	 Enter Keys: It is labelled with ‘Enter 8 ’. It is one of the most commonly used key of 
the keyboard. On a desktop keyboard, this key is placed in the middle as well as at the 
bottom right corner of the keyboard. It helps to move the cursor to the next line and to 
execute any instruction after typing.

•	 Escape (Esc) Key: It is labelled with ‘Esc’. It is placed on the upper side at the left corner 
of the keyboard.

•	 Spacebar Key: It lies at the bottom of the keyboard. It helps to give space (gap) between 
two letters or words.

2.
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•	 Shift Key: This key is labelled with ‘Shift’ and an arrow pointing in the upward direction. 
There are two such keys, one at the left side of the keyboard and the other below the 
‘Enter’ key. It is used to type in capital letters or to type special characters.

•	 Ctrl key: This key is used in conjunction with other keys of the keyboard to produce 
control characters or instructions. Alt key is like a second control key.

•	 Caps Lock Key: This key is labelled with ‘Caps Lock’. It lies on the left side of the keyboard. 
It helps to type the alphabet in ‘Capital’ letter when ‘ON’ and in small letter when ‘OFF’.

•	 �Backspace Key: This key is labelled with ‘Backspace’ or with a left arrow. When pressed, 
it erases the character which are present on the left side of the cursor.

•	 Delete Key: This key is used to erase the characters. When pressed, it erases the character 
present on the right side of the cursor.

 	 2.	 i.  Tab			   ii.	 Start the lesson			  iii.	 Restart the lesson
		  iv.  Student toolbar
	 3.	 Correct position of the hands and body while typing:
		  •	� The chair and table height should be such that the shoulder, arm, and wrist muscles are 

free from any strain.
		  •	� The wrists can touch the tabletop. However, do not put even a small portion of your body 

weight to your wrists.
	 4.	 It lies above the virtual keypad. It displays the lesson length, progress of the lesson and 

sound controller. Status Bar consists of two progress bar:
		  •	� Green progress bar shows the percentage of completion of the current lesson.
		  •	� Yellow Progress Bar reflects the acceptable time for typing a character. When Yellow 

progress bar runs out, it is recorded as a ‘Slowdown’ mistake.
	 5.	 It is a way to check the accuracy, speed, slow keystrokes, common error, etc. in a single window. 

Each time the typist completes a lesson, the Results window displays the achievements in 
that lesson and offers a range of further action. It consist of ‘Next step’, ‘Detailed statistics’, 
‘Error overview’ tab.

		�  Next step: Next step tab suggests options for the next step viz. ‘Go to the next lesson’ and 
‘Try again’ after comparing results with Course goals in the Course options. If the typist has 
performed well in all the three parameters; viz., speed, accuracy and time-out, the software 
suggests for going to the next lesson.

		  ��Detailed statistics: On the second tab, one can see the lesson statistics in detail along with 
the typing speed  and errors / slowdowns for each character / keystroke in the following 
manner: 

		  •	� The green dashed line in the diagram shows good and bad results; the good results appear 
above the line.

		  •	 If the result is bad; the column is red, if the result is good; the column is green. 
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		  •	 In keystroke diagrams; the key names are of the same colour as that of the finger zone.
		  Errors overview: On the third tab, one can check the errors that occurred during the typing 

lesson.
		  The letters in different colours indicate the following: 
		  •	 Green indicates correct character. 
		  •	 Yellow colour is an indication that the time frame of typing has been exceeded.
		  •	 Red indicates incorrect character.
		  •	 Orange indicates both incorrect character as well as exceeding of the time frame.
	 6.	 The letters in different colours indicate the following: 
		  •	 Green indicates correct character. 
		  •	 Yellow colour is an indication that the time frame of typing has been exceeded.
		  •	 Red indicates incorrect character.
		  •	 Orange indicates both incorrect character as well as exceeding of the time frame.
	 7.	 i.	� It is a type of on-screen keypad which helps to learn typing with all the ten fingers.
		  ii.	� Lesson controlled section allows the user to start/suspend the current lesson, restart from 

the begining and monitor the current speed, accuracy and time elapsed in real-time.
		  iii.	� ‘Overall Rating’ is evaluated on the basis of speed, accuracy and slowdown keystrokes. It 

is displayed with the help of indicator which ranges from ‘Could be better’ to ‘Excellent’. 
Indicator colours have significance which varies with the change of range.

	 8.	 i.	� ‘F’ and ‘J’ keys are called Guide keys. They contain a small raised tangible mark to help 
the typist to place their fingers correctly on the Home keys. Alphabets ASDF are home 
keys for the left hand and ; (semi-colon) LKJ for the right hand.

		  ii.	 Enter, Arrows, Shift, Spacebar.
	 9.	 Typing Ergonomics is the science of preventing common injuries by using proper posture 

and stretching techniques when working on a computer. 
		  Some of the key points of typing ergonomics are:
		  •	� The ideal typing posture is such that the keyboard is below the elbow height when seated, 

with the wrists straight and not planted on the surface of the desk.
		  •	 The right sitting position involves:
			   s	Resting the back against the chair for maximum support. 
			   s	Resting the feet flat on the floor or on a footrest. 
			   s		Looking straight ahead without leaning forward. 
			   s	�The top of the monitor must be at the same level or slightly below the horizontal eye 

level.
			   s		Positioning the knees at the same level or slightly lower than the thighs.
			   s	Relaxing the shoulders.



7Touchpad Information Technology-IX (Answer Key)

		  •	 Avoid pounding on the keys and do not exert more force than is necessary.
		  •	 Take short breaks every thirty minutes and move around.
	 10.	 The text panel of lesson editor is used to edit, modify, insert and delete the selected lesson.
B. 	 1.	 Toolbar.
	 2.	 Yashika can use Errors Overview tab of Result Interpretation window for the purpose.

	Digital Documentation: Word Processor�

Unit 3: Digital Documentation

Unsolved Exercise
Section A

A. 	 1.	 iii	 2.	 ii	 3.	 iii	 4.	 iv	 5.	 i
B. 	 1.	 Not in dictionary	 2.	 Ctrl + F10	 3.	 Cut	 4.	 Inserting	 5.	 editing

Section B
A. 	 1.	 Clipboard is a temporary storage area that stores the object which has been cut or copied for 

future use. Whenever one uses the ‘Paste’ option the object from the ‘Clipboard’ is retrieved 
by that application.

	 2.	 i.	 Ctrl + Shift + F8
		  ii.	 Shift + Down/Up arrow
		  iii.	 Ctrl + Shift + Down/Up arrow
	 3.	 The advantages of a word processor over typewriters are:
		  •	 Writing text for the document that has large number of papers.
		  •	 Editing & changing some content after composing it.
		  •	 Moving content from one part of the document to another.
		  •	 Changing the width (side wise) of page margins of the papers in a document.
		  •	 Adding new pages in between the pages of the document.
		  •	 Doing corrections of spellings & checking grammar of textual contents of the document.
		  •		 �Searching a particular word or phrase in the document and replace it with the other word.
	 4.	 To find and replace a word or phrase or text in ‘Writer’, follow the steps:
		  Step 1:	 Click on the ‘Find & Replace’ option from the ‘Edit’ menu. ‘Find & Replace’ dialog 

box opens:
		  Step 2:	 Type the text to be searched.
		  Step 3:	 Type the text with which it has to be replaced with.

3.
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		  Step 4:	 Click on ‘Find’ to find the matched text.
		  Step 5:	 Click on ‘Replace’ to ‘Replace’ the matched text..
		  Step 6:	�� Repeat the step as many times as required or click on ‘Replace All’ to replace all 

relevant text.
	 5.	 Making changes in the existing text is known as ‘Editing’. After entering text in a document, 

the user may wish to modify the contents. Editing of a document involves modifying, 
inserting, deleting the selected text of a document. Edit menu provides various editing 
options like Undo, Redo, Cut, Select, Copy, Paste, etc., which helps in modifying the contents 
of a document.

	 6.	 The ‘Page Preview’ option displays the print layout or a miniature view of how a document 
would look when it actually gets printed on a paper.

	 7.	
Control Box

Horizontal
Ruler

Vertical 
Scroll Bark

Tab Control

Status Bar Zoom

Document Window/
Work Area

	 8.	 i.	� It lies at the bottom of the application window. It displays information that includes Page 
number, Page style, Language and Type of view (magnification percentage), etc.

		  ii.	� It lies below the ‘Menu bar’. It contains shortcut buttons which provide quick access to 
frequently used commands like New, Open, Save, Print, etc.

		  iii.	� It lies at the top of the screen. It displays the name of the active document. In Title Bar, 
there is a control box at the left corner and Minimize, Maximize/Restore and Close 
buttons are at the right corner.

	 9.	�� In a word processor, graphical pictures can be added in the document. There are various 
tools to draw shapes and designs in word processors.

	 10.	 A user can easily switch from one page to other page of a document instantly in a word 
processor to view or edit it.

B. 	 1.	 Yes, Mail Merge.
	 2.	 Use Copy-Paste feature.
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	Formatting in Word Processor� Unit 3: Digital Documentation

Unsolved Exercise
Section A

A. 	 1.	 iii	 2.	 i	 3.	 i	 4.	 iv	 5.	 iii
B. 	 1.	 Portrait	 2.	 Ctrl + I	 3.	 F5	 4.	 File	 5.	 beginning, end

Section B
A. 	 1.	 Merging Cells: Combining two or more adjacent cells in the same row or column is known 

as merging of cells.
		  Splitting Cells: Division of cells into two or more sub-cells is known as splitting of cells.
	 2.	 Paragraph spacing is the space or the gap between two paragraphs. Space can be specified 

in lines or in points.
		  The ‘Above paragraph’ is used to increase or decrease the space between the selected 

paragraph and the paragraph before the selected one whereas the ‘Below paragraph’ is 
used to increase or decrease the space between the selected paragraph and the paragraph 
next to selected one.

	 3.	 0.5”.
	 4.	 Find and Replace, Ctrl + H.
	 5.	 Tools → Word Count.
	 6.	 Steps to insert a mathematical expression in a document:
		  Step 1:	� Select ‘Object’ from the ‘Insert’ menu and choose the option ‘Formula’ from the 

submenu. Formula window appears on the screen.
		  Step 2:	 Right click on the ‘Edit Window’.
		  Step 3:	 Select the desired formula type.
		  Step 4:	 ‘Elements’ dialog box appears with several options. Select the desired expression 

say ‘a>b’. The expression will appear as ‘<q> > <q>’ in the document and appears 
as ‘<?> > <?>’ in the ‘Edit’ window. Edit the given expression as per the need in 
edit & Element window.

		  Step 5:	 After inserting the expression erase the right and left angular bracket & click 
anywhere in the document window to close the Edit window.

	 7.	 Header and Footer is the mark of identification or reference of the text which is displayed on 
every page of a document. Header or Footer contains information such as page numbers, 
date, logo of a company, title or file name of the document, etc.

		  Header is the repetitive text that is printed at the top of every page where as footer is the 
repetitive text that is printed at the bottom of every page in a document. By default, header 
or footer is printed at 0.5” gap from the edge of the page. One can apply the same header 
or footer in the document or in some pages of a document.

4.
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	 8.	 Different options of Line spacing are:
		  •	� Single: It provides single line spacing, according to the point size of the font. It is the 

default line spacing that exists in a normal document.
		  •	� 1.5 lines: It provides one and a half line size spacing, according to the point size of the 

font.
		  •	 Double: It provides double line spacing, according to the point size of the font.
		  •	� At least: It sets minimum spacing between the lines. This option is useful if there are fonts 

and lines of different sizes in the paragraph.
		  •	 �Proportional: It allows to enter a percentage value in the box for line spacing, where 

100% corresponds to a single line spacing.
		  •	 Leading: It sets the height of the vertical space that is inserted between two lines.
		  •	 �Fixed: It sets the line spacing to exactly match the value that is entered in the box. This 

can result in cropped characters.
	 9.	 Steps to save the document in OpenOffice Writer:
		  Step 1:	 Select  ‘Save As’ option from the ‘File’ menu. ‘Save As’  dialog box opens as:
		  Step 2:	 Browse the location to save the document.
		  Step 3:	 Type the ‘File name’ in the File name box.
		  Step 4:	 Click on ‘Save’ button.
	 10.	 Advantages of using Table are:
		  i.	 Visual grouping of information.
		  ii.	 Easy to find information.
		  iii.	 Efficient summarisation of information.
		  iv.	 Make data more understandable.
		  v.	 Reduce complexity of information.
B. 	 1.	 Tables
	 2.	 Footer

	Mail Merge� Unit 3: Digital Documentation

Unsolved Exercise
Section A

A. 	 1.	 ii	 2.	 iv	 3.	 ___	 4.	 ii	 5.	 ii
B. 	 1.	 OpenOffice.org		 2.	 Main Document		  3.	 Data source
	 4.	 Salutation			   5.	 Letter

5.
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Section B
A. 	 1.	 Mail Merge is a feature of Word processor like ‘Writer’, in which name and address of different 

recipients are merged in one file and each address is merged with a copy of particular letter 
by itself, so that the same letter is addressed to different recipients.

	 2.	 Steps to edit document in Mail Merge:
		  Step 1:	 Click on ‘Edit Document ...’ button. 
		  		  ‘Writer’ window appears on the screen. Here the user can modify the document.
		  Step 2:	 After editing work, click to open the previous window. 
		  Step 3:	 Click on ‘Next’.
	 3.	 The main document contains the contents of the letter that remains the same for each of the 

merged document, it may contain text, letter, graphics, etc. It also contains the field names 
and address that retrieves names from the data source file of address.

	 4.	 WordStar, Word, Writer, Word Perfect.
	 5.	 To insert a comment to be associated with a recorded change: 
		  Step 1:	 Place the cursor at the text and click on Insert  Comment .
		  Step 2:	� It will display a yellow rectangular box towards the text for which comment is to 

be inserted. Type the notes in the box.
B.   Track changes

	Working with Spreadsheet� Unit 4: Electronic Spreadsheet

Unsolved Exercise
Section A

A. 	 1.	 i	 2.	 iii	 3.	 ii	 4.	 i	 5.	 i
B. 	 1.	 1024	 2.	 Format  Character	 3.	 .ods	 4.	 three
	 5.	 Cell Pointer

Section B
A. 	 1.	 User can hide worksheet(s) of a workbook which can be displayed later. To hide a worksheet:
		  Step 1:	 Select the sheet(s) to be hidden.
		  Step 2:	 Select the option ‘Sheet’ from the ‘Format’ menu. Click on the ‘Hide’ option.
		  Step 3:	 Click on ‘OK’ Button.
	 2.	 A user can add more sheets, if required. To add new sheets in the workbook:
		  Step 1:	 Right click on ‘Sheet’ tab and select ‘Insert Sheet’ option. ‘Insert Sheet’ dialog box 

appears.
		  Step 2:	 Set the position where the new sheet is to be added in the workbook.

6.
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		  Step 3:	 Specify the number and the name of sheet to be created.
		  Step 4:	 Click on the ‘OK’ button.
	 3.	 Each cell has a unique address which identifies its location. A cell address is identified with 

its column position followed by its row number, for example: ‘A5’ is the cell address that is 
a combination of column ‘A’ and row ‘5’.

	 4.	 The “Shrink to fit cell size” feature automatically reduces the font size in a cell so that the 
text fits inside the cell without wrapping.

	 5.	 Two operations performed on the data in a spreadsheet are:
		  i.	 Use of formulae for calculations.
		  ii.	 Use of charts for pictorial display of information.
	 6.	 Formulae are entered to perform mathematical operations such as addition, subtraction, 

multiplication, division, etc. Formula entry in a cell is logical entry. It shows the relationship 
between different cells. In Calc or Excel, a formula always starts with an euqal (=) sign.

	 7.	 OR:		 �Produces true if any condition enclosed in bracket is true, otherwise it produces 
false. 	Eg. =OR(5>3; 4<5;4>15) will display true.

	 			   =OR(3>6; 2<1) will display false.
	 	 AND:	� Produces true if all the conditions enclosed in bracket is true  otherwise displays 

false.
	 			   Eg.=AND (5>3; 4<5; 4>15) will display false. (As one of the condition is false)
	 			   =AND(5>3; 4<5) will display true. (As all of the conditions are true)
		  IF:		�  If the condition in the statement is true, it will display the true part otherwise it will 

display the false part.

				    Eg. =IF(4>5;4;5) will display 5 since the condition is false.
	 8.	 Given below is the list of errors which commonly occurs in ‘Calc’.

Errors Reasons

####
Occurs when the cell contains a number, data or time that is wider than 
the Cell width or when the cell contains a date and/or time formula that 
produces a negative result.

#VALUE Occurs when the wrong type of argument or operand is used.

#NAME Occurs when ‘Calc’ does not recognize text in a formula.

#NUM Occurs when there is a problem with a number in a formula or function.

#REF! Occurs when a cell reference is not valid.

#DIV/0! Occurs when a formula is divided by zero.
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	 9.	 i.	 MAX( ):	 	 �Produces the largest value from the given range of cells. 
					     Eg. =MAX(10;20;15;25) Displays output:25 
					     = MAX(A1:A5) Displays the largest value from cell A1 to A5. 
					�     = MAX(B2:C4) Displays the largest value of cells B2, B3, B4,C2, C3 and   

C4.
		  ii.	 AVERAGE( ):		  Produces the average (mean) of the given arguments.
					     Eg.=AVERAGE(10;20;30) Displays output: 20
					     =AVERAGE(A1;A2;A3) Displays the average of the cells A1, A2 and A3
					�     =AVERAGE(A1:A10) Displays the average of the cells from the range A1 

to A10
		  iii.	 COUNT():		  Produces the number of arguments enclosed in small brackets.
					     Eg. = COUNT(1;2;15;25;3;6) Displays output :6
					�     = COUNT(A1:A20) Displays output: 20 (If all cells i.e., A1 to A20 contains 

values).
	 10.	 A group of cells is known as a cell range. A range comprises of two or more selected cells 

and those selected cells need not be adjacent to each other.
		  •	� Vertical/Column Range: Column range is the number of selected cells spread across the 

column.
		  •	� Horizontal/Row Range: Row range is the number of selected cells spread across the 

row.
		  •	� Mixed Range: Mixed range is the number of selected cells spread across the row and 

column.
B. 	 1.	 Spreadsheet
	 2.	 E9

	Formatting Cells in Spreadsheet

Unit 4: Electronic Spreadsheet

Unsolved Exercise
Section A

A. 	 1.	 i	 2.	 iv	 3.	 i	 4.	 iii	 5.	 i
B. 	 1.	 Format Cells			   2.	 Formatting tool			  3.	 Formatting
	 4.	 Auto Fill			   5.	 Chart

7.
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Section B
A. 	 1.	 Steps to insert a chart in calc are:
		  Step 1:	 Select the data.
		  Step 2:	 Select the ‘Chart’ option from the ‘Insert’ menu.
		  Step 3:	 Select any type of chart from the list.
		  Step 4:	 Click on ‘Next’.
		  Step 5:	 Enter  appropriate range of cells. (To alter the range click on the ‘Data Range’ 

option.)
		  Step 6:	 Select the range of cells to display chart.
		  Step 7:	 Click on ‘Next’ button.
		  Step 8:	 Select the data range from the list for Name and Y-Values.
		  Step 9:	 Edit data series from other cells.
		  Step 10:	Click on ‘Next’.
		  Step 11:	Mention the title and subtitle of the chart.
		  Step 12:	Click on the check box.
		  Step 13:	Click on ‘Display Legend’ checkbox and set the position.
		  Step 14:	Click on ‘Finish’.
	 2.	 The two operations that can be performed on data in a spreadsheet are:
		  i.	 Use of formulae for calculations.
		  ii.	 Use of charts for pictorial display of information.
	 3.	 Formulae are entered to perform mathematical operations such as addition, subtraction, 

multiplication, division, etc. Formula entry in a cell is logical entry. It shows the relationship 
between different cells. In Calc or Excel, a formula always starts with an euqal (=) sign.

	 4.	 Default, Left, Right, Center, Filled, Justified.
	 5.	 Cell can be formatted to hold different version of time. To do so:
		  Step 1:	 Select the range of cells.
		  Step 2:	� Click on the ‘Format’ menu and then select ‘Cells’ option. ‘Format Cells’ window 

appears on the screen.
	 6.	 Steps to format font of a cell content in a worksheet are:
	 	 Step 1:	 Select the contents of cell or range of cells.
		  Step 2:	 Select the option ‘Cells’ from the ‘Format’ menu. ‘Format Cells’ dialog box opens.
		  Step 3:	 Click on the ‘Font’ tab.
		  Step 4:	 Select the appropriate Font, Typeface, Size.
		  Step 5:	� Click on ‘Font Effects’ tab to select the appropriate option of Font color, Overlining, 

Strikethrough, etc.



15Touchpad Information Technology-IX (Answer Key)

		  Step 6:	 Click on the ‘OK’ button to implement the changes.
	 7.	 It is an additional feature in spreadsheet package like ‘Calc’ in which a certain kind of 

predefined series of data such as name of months of a year, serial numbers, etc. are 
automatically generated once the user feeds the initial data.

	 8.	 Data Series is the range of cells selected to create a chart in Calc.
	 9.	 To create a Custom list:
		  Step 1:	 Select ‘Options’ from the ‘Tools’ menu. ‘Options’ dialog box appears on the screen.
		  Step 2:	 Click on the ‘+’ beside OpenOffice Calc.
		  Step 3:	 Click to display predefined series of list.
		  Step 4:	 To generate own list, click on the ‘New’ button.
		  Step 5:	� Fill the series in entries section and then click on ‘Add’ button to insert the user 

defined entries in the list, then click on ‘OK’ button.
	 10.	 The contents will be displayed within the column width only. The data which does not get 

accommodated in the cell width will be hidden in the cell.
B. 	 1.	 Formulae
	 2.	 Column/Bar Chart

	Working with Presentation� Unit 5: Digital Presentation

Unsolved Exercise
Section A

A. 	 1.	 i	 2.	 iii	 3.	 iv	 4.	 i	 5.	 iv
B. 	 1.	 Presentation			   2.	 Slide Pane	 3.	 Workspace	 4.	 Alt + I + E
	 5.	 Home, End

Section B
A. 	 1.	 i.	 Spelling and Grammar  ii. Zoom  iii. Slide Show  iv. Font Size
	 2.	 Presentation package can be used for different purposes like:
		  •	� On-Screen Presentation: Presentation packages can be used to create exciting and 

effective on-screen presentations that can be displayed through LCD projectors or LED 
TVs. They include movies, sounds, animations, etc.

		  •	� Web Presentation: Presentation package can be used for displaying presentation on 
web. Thus, presentation can be made accessible to people staying in remote places of 
the world.

		  •	� 35 mm Slides: The electronic slides or pages can be used to make 35mm slides for 
different purposes.

8.
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		  •	 �Overhead Transparencies: The slides made in a graphical presentation package can be 
printed on transparent sheets facilitating overhead presentations.

		  •	� Handouts and References: The outline of slides can be printed on a paper which can be 
used for reference purpose and the matter of the slides can also be used as notes.

	 3.	 In normal view (by default) a blank slide appears on the workspace. It enables a user to make 
presentation as per the need. It is helpful while designing presentation of large number of 
slides. It sets the standard for viewing slides.

 	 4.	 i.	� The handout view enables to prepare a hard copy or summary of the presentation. With 
this view, the user can print many slides in a single page. (Often the Handout tab is not 
viewed as a template).

		  ii.	� In the notes view, the slides are displayed in a reduced form on top of the page. Towards 
the bottom side, there is a text box in which notes for the slide can be added.

		  iii.	� Outline View displays the slides of a presentation in the miniature format which is without 
backgrounds, colours, graphics, etc.

			�   It is a useful option for quickly browsing the presentation or reviewing the presentation. 
In an outline view, only the text layout is displayed (Slide Title and Main text). 

			�   It is useful for editing the text since the text of several slides appear on the screen at the 
same time.

		  iv.	� Template is a predefined format, background and colour layout that can be applied to 
a presentation, but it does not include any content.

	 5.	 As Header
	 6.	 Watermark is a faded image of a design that is printed as background. In slides, it appears 

as a shadow. Watermark acts as identification on the screen and it is used to show logo, 
mark of products, etc. To insert watermark in the slide:

		  Step 1:	 Insert the graphic (Picture, Chart, etc.) in the slide which has to be used as watermark.
		  Step 2:	 Click on ‘Color mode’ from the Graphic sidebar deck and select ‘Watermark’.
	 7.	 Header and Footer is the information of a page which is separated from the main body of 

the text and appears at the top and the bottom of the page.
		  To make the presentation more effective and informative, the user can write the topic name, 

date & time, slide number and the event name for which the slides are presented. The user 
can display the slide number as the footer. Header is visible only in Notes and Handout view.

	 8.	 Portable Document Format (PDF) preserves formatting of the slide and enables file sharing 
without any changes in the formatting style of presentation. When the PDF format file is 
viewed online or printed, it retains the original format of the presentation. Confidential 
presentation must be in pdf format as this format is non editable in general cases.

	 9.	 Empty presentation, From Template, Open Existing Presentation.
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	 10.	 It generally lies beside the standard tool bar to the right side of the screen. The buttons 
found on this bar are:

		  	 Slide		 It enables to add a new slide in the presentation.
		  	 Slide Layout	 It enables to reset the slide with a new slide layout.
		  	 Slide Design	 It enables to apply background design to a slide.
		  	 Slide Show		 It enables to show the presentation in a full screen.
B. 	 1.	 .gif, .jpeg, .gif, .png
	 2.	 Animation

	Digital Slides� Unit 5: Digital Presentation

Unsolved Exercise
Section A

A. 	 1.	 iii	 2.	 iv	 3.	 i	 4.	 iv	 5.	 ii
B. 	 1.	 Handout	 2.	 Slide Show	 3.	 Object	 4.	 master	 5.	 .odp

Section B
A.	 1.	 Image, Animated Image, Movie, Sound, Chart.
	 2.	 To Modify Background Colour:
		  Step 1:	 Select ‘Page’ from ‘Format’ menu.
		  Step 2:	� On the ‘Background’ tab, select the ‘color’ option from ‘Fill’ drop down box and 

select a colour for the background and click on the ‘OK’ button.
		  To add shaded Background:
		  Step 1:	 On the Background tab, select ‘Gradient’ option. Or, to add a Textured Background.
		  Step 2:	 Choose the desired gradient.
		  Step 3:	 Select ‘Hatching’ option. 
		  Step 4:	 Choose the desired pattern.
		  Step 5:	 Click on ‘OK’ button.
	 3.	 The Header fields are used to enter chapter name, book name, company logo, etc. The Footer 

fields are used to enter page number, author’s name, date and time, etc.
	 4.	 Tips for effective presentation are:
		  i.	 Prepare well about the topic of the presentation.
		  ii.		 Cover most important points in the beginning.
		  iii.	� Be aware of who is going to be the audience – teacher, students, parents, businessmen, 

etc.

9.
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		  iv.	 Rehearse and practice well for the presentation.
		  v.	 Keep the slides simple.
		  vi.	 Use limited words on slides.
		  vii.	 Use photographs and pictures of high resolution and quality.
		  viii.	Use relevant charts.
		  ix.	 Use accurate data from reliable sources.
		  x.	 Choose appropriate fonts.
		  xi.	 Choose eye-catchy colour combination.
		  xii.	 Keep the formatting clean and simple.
		  xiii.	Suitably align the objects on the slides.
		  xiv.	Practice well using the timer.
		  xv.	 Don’t speak too fast, let the audience understand and think what you want to convey.
		  xvi.	Use voice modulation for emphasising different parts of the presentation.
		  xvii.	Do not use too much animation and transitions.
		  xviii.	Use professional graphics instead of clipart.
		  xix.	Customise the templates according to your requirements.
		  xx.	 Interact with the audience in between the presentation.
	 5.	 To ungroup objects:
		  Step 1:	 Right-click on the grouped image. A context menu appears on the screen.
		  Step 2:	 Select ‘Ungroup’ from the context menu.
	 6.	 To resize an image, follow the given steps:
		  Step 1:	 Select the image by clicking on it. Observe the displayed selection handles.
		  Step 2:	� Position the mouse pointer over one of the selection handles. The cursor changes 

the shape giving a graphical representation of the direction of the resizing.
		  Step 3:	 Click and drag to resize the image.
		  Step 4:	 Release the mouse button when satisfied with the new size.

	 7.	 i.	 Select the content to be copied, then click the ‘Copy’ command on standard toolbar.
	 	 ii.	 Place the insertion point on the desired area where content is required to appear.
		  iii.	 Press ‘Ctrl+V’ keys from keyboard.
		  iv.		 The copied text will appear at the insertion point.
	 8.	 A multimedia software is one that can be used to play or record audio as well as video using 

peripheral devices.
	 9.	 The various components of a slide that can be used for reference purpose are Screens, Dialog 

boxes, Buttons, Content, Formatting and Playback options.
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	 10.	 A slide is a single page of a presentation. On the other hand, a slideshow is a display of series 
of slides on a projectable device.

B. 	 1.	 Using Themes and Slide Masters
	 2.	 Handouts




